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Advanced Topics in Web Designing

9.1 INTRODUCTION

A first impression does make a lasting impression. Good use of
color contrasts, rich in content and graphics, animation,
cartooning, audio, video, and interactive websites always creates
a good impression at the first sight in the visitor’s mind that lasts
for ever.

All the above stuffs can be achieved by using special tools like
image creation and editing using Adobe Photoshop, creation of
animation and movies using Macromedia Flash tool.

9.2 OBJECTIVES

After going through this lesson, you would be able to:

| use of FrontPage Active Elements

| explain the concept of Multimedia in a webpage

| create and Edit images using Adobe Photoshop

| explain Animations and Movies using Macromedia Flash
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9.3 DHTML

DHTML (Dynamic Hyper Text Mark-Up Language) is a new web
page creation software tools that allows on the fly modification on
the web page. It provides the ability to create pages that can
changes their structure, content, or appearance to user input,
without requesting any data from the server. All the following
DHTML components discussed below are in reference with
FrontPage 2000

9.3.1 Using Hover Button

Hover Button is a feature of FrontPage 2000 that allows you to
create animated buttons that change form or color when the
mouse pointer is moved over them. Hover Buttons can give life
to your web pages. They seem to “come alive” and are great for
producing a navigation bar for your site.

To add a hover button:

1. Click Insert a Component a Hover Button
Hover Button Properties HE
Buttaon text: IMain Page Farnt...
Lirk to: Ihttp:;’;"www.wehdevelnpersinurnal.cnm Browse...

Buttan color: I_ j Background color: | I Autom: *

Effect: IGl':'W j Effect colar: [ ] hd
ficith: |12III Height: |24
0K | Canicel |
Fig.9.1
2. Type some text that will appear on your button.
3. Type or paste in a URL to link to, or browse your Web for

another page to link to.
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4. Choose the button color, effect, background color and effect
color.

5. Specify dimensions if desired.

6. Click OK.

In the example buttons above, the Glow effect was used. The
Maroon buttons glow with a red color when the mouse is moved
over them.

9.3.2 Using Banner Ad Manager

Banner Ad Manager uses a list of images and displays each for a
preset number of seconds and switches to the next, until it is
finished with the list. It then starts again from the beginning. You
can also take the user to a different URL when clicked over the
Ad Banner.

To add a Banner Ad Manager:

1. Click Insert a Component a Banner Ad Manager

— LI} ~
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. width: W_ Height: [170
Transition effect: I Dizzolve ;I
Show each picturg for [secondsz]: IB—
Link, ta:

I Browse. .

Pictures to dizplay:

Bemove

tMove Up

i

b e Dowvn
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E3 =6 seconds over 288 [ [HUM 2

Fig 9.2
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2. Mention the Width and Height as 170. Increase the show
picture durationto 8 Seconds. Laterclick Browse... button
to link a page.

Select the URL of the page to make a Link.

4. Add Pictures to display. Select  Add... to include images to
the Banner. Include as many images as in the same way.
Click the OK button.

Fig. 9.3

To view the output, Select  Preview in Browser  option in File
menu.

9.3.3 Using Hit Counter

Hit counters are commonly used on
Web pages to track the number of times the page has been
accessed. You must have seen a hit counter like the one given
below in some of the web pages.

This defines the number of times
the same web page is accessed by the users or in other words
number of visitors visited this particular site.
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To add a Hit Counter:

1. Click Insert a Component a Hit Counter

Fig:9.4

Chnnea the rir:];\ph|c style you pl’efel’

1 can give the counter an initial value. The

~ar as text until you save the page out to the

f”ﬂ!ﬂii']'ll ' vith your browser.

- HEREEEERER

TR an almlmat_(l?rcll_ mes?_agcle on yolur pagtget_wherfl it
i = =xplorer. This particular implementation o

> only works in Internet Explorer browsers,

or ] _ Cocn | JavaScript code to place in your page that
will do the same thing and appear on all 3.0 and later version of
Internet Explorer web browsers.

THIS DOES NOT WORK IN NETSCAPE BROWSERS.

To add a Marquee:
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1 Click Insert a Component a Marquee

2 Type in some text

3. Choose your settings — direction, effect, speed, etc.
4 Click OK.

9.4 MULTIMEDIA

As the term indicates, multimedia is a combination of many
different media : text, graphics, sound, animation and video clip.

9.4.1 Using Sound

The capability to play a sound as a visitor interacts with the web
pages greatly enhances the attractiveness and effectiveness of a
page. But the problem with sound is that even a few seconds
worth of audio takes a good amount of time to download, a minute
or two of it, depending on the file format and quality. So as a rule
of thumb, one should keep audio clips short, enough to make
file sizes 20k or lesser.

The most commonly used audio file formats are:

MIDI (Musical Instrument Digit al Interface), MP3 (MPEG Layer
3 Audio file), AU, WAV (windows WAVE sound) etc.

%] Embedding sound into a HTML document

Embedded Sound in a HTML file that plays automatically when
the page loads.

The format for an Embed:

<EMBED SRC="filename.extension” AUTOSTART="TRUE" LOOP="2"
HEIGHT="145" WIDTH="100" ></EMBED>

EMBED tells the browser an embed sound is here — go get the
plug-in (small program that helps to run sound files). Remember,
embed commands are associated with plug-ins.

Note: If no plug-in is available, the browser will do one of three
things:

1. Do nothing. This is true of very early level browsers or
browsers other than Netscape.
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2. Put up a dialogue box asking you how you want to handle
the file.

3. Tell you a plug-in is needed and ask you if you'd like to go
get it.

Important attributes of EMBED tag:

| SRC="filename.extension" is pretty straight-forward. That
is the name of your music file and the proper extension for
your particular file. If it is a MIDI file named Sunset then
you will code SRC="Sunset.mid".

| AUTOSTART to TRUE to play the sound by itself on page
load.

| LOOP to specify the repetition of sound in number of times.

| HEIGHT/WIDTH  deals with the plug-ins control panel size
on the page. If you don’t want the plug-in to display in page
make the Height and Width to O.

Width, height, and auto  start are all required parameters
for the control that will be displayed when the page loads.

This code should be coded immediately after the body tag
if it is to be played automatically upon page load.

An example showing embedding audio file sing.au inside HTML
document

<html>
<head>
<titte> Embedded Audio file in HTML document<title>
</head>

<body>

Audio File has been embedded inside this document, which will
run automatically on loading the page.

<EMBED SRC-="sing.au" AUTOSTART="TRUE" LOOP="2"
HEIGHT="145" WIDTH="100" >

</EMBED>
</body>
</html>
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2} Embedded Audio file in HTML document - Microsoft Internet Explorer
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Audio File has been embedded inside this document, which will run automatically on loading the page.

.’iﬁl Done j My Computer

Fig. 9.5

9.4.2 Using Video

Embedding a video follows the same basic format as embedding
a sound. Even the same attribute commands, like AUTOSTART
and LOOP, all work in a similar fashion.

The most commonly used audio file formats are:

AVI (Audio Video Interleave file), MPEG (Moving Picture Experts
Group video file), SWF(Macromedia Flash Movie), WMV (Windows
Media Video)

<EMBED SRC="mymovie.swf' WIDTH="200" HEIGHT="100"
AUTOPLAY="TRUE"></EMBED>

Important attributes of EMBED tag

| SRC: This is a required attribute and takes the video movie
URL as its value.

| WIDTH and HEIGHT : Required attributes. They specify the
dimensions in pixel values.

| AUTOPLAY : Its value can be either TRUE, movie plays
when page loads, or FALSE, which waits for the user to click
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the play button.

| LOOP: Setting this to TRUE will play the movie
continuously. A FALSE value will play the movie only once.

9.4.3 Animated GIF

An animated gif is the collection of a number of images (frames)
which when played in sequential order makes a movie like effect.
GIF animation doesn’t give the same level of control and flexibility
as other animation formats but it has become extremely popular

because it is supported by nearly all Web browsers. In addition,

animated GIF files tend to be quite a bit smaller that other
animation files

Let us start off with a check list of all the things you need to create
animated gifs.

| An imaging software such as Paint Shop Pro(PSP) or
Colorworks.

| A gif assembling software such as Gif Animator, Animation
Shop, Giffy

| Your own Misualisation and creativity and

| A lot of patience

A number of software program’s are available either for free or
shareware on the Internet.

9.5 IMAGE PROCESSING USING PHOTOSHOP

The state-of-the art tool Photoshop is basically used to edit
images with its comprehensive set of retouching, painting, and
drawing tools. It's not only limited to editing images but also very
much useful for creating flashy logos, buttons, expressive artistic
text, designing impressive web page and wide variety of other
graphic images.

9.5.1 Getting started with Photoshop

To open Photoshop: click Start Y All Programs Y Adobe
Photoshop 7.0
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This will open the work area of Photoshop where you can create
and edit images.

Fig. 9.6 : Photoshop work area

The work aea consists of the following components:

Menu bar

The menu bar contains menus for performing tasks. The
menus are organized by topic. For example, the Layers
menu contains commands for working with layers.

Options bar

The options bar provides options for using a tool.
Toolbox

The toolbox holds tools for creating and editing images.

Palette well

The palette well helps you organize the palettes in your
work area.
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| Palettes

Palettes help you monitor and modify images.

v Using the tool options bar

Most tools have options that are displayed in the tool options bar.
The options bar is context sensitive and changes as different tools
are selected.

You can move the options bar anywhere in the work area, and
dock it at the top or bottom of the screen.

To display the tool options bar:
Do one of the following:
| Choose Window Y Options.

| Click a tool in the toolbox.

E ’Y 2 -] @ﬂ[? [H Feather: [ p;.é "] il Anti-aliased

Lasso options bar
v Using the toolbox

The first time you start the application, the toolbox appears on
the left side of the screen. Some tools in the toolbox have options
that appear in the context-sensitive tool options bar. These
include the tools that let you use type, select, paint, draw, sample,
edit, move, annotate, and view images. Other tools in the toolbox
allow you to change foreground/background colors. The different
tools and their description:
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The marquee tools

Make rectangular,

The move tool

Moves selections,

The lasso tools

Make freehand,

The magic wand
tool

elliptical, single | layers, and | polygonal Selects similarly

row, and single | guides. colored

column selections.

The crop tool [The slice tool [The slice selection | The healing

trims images. creates slices. tool selects slices. | brushtool paints
with a sample or
pattern to repairs
imperfections

The patch tool
Repairs imperf-
ections in a
selected area of
animage using a
sample or
pattern.

The brush tool
paints brush
strokes.

The pencil tool
paints hard-
edged strokes.

The clone stamp
tool Paintswith a
sample of an
image.
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The pattern stam
tool paints with par
of an image as

T he history brushThe art history brus
tool paints a copy oftool paints with
Hhe selected state ¢stylized strokes tha

N he magic eraser to@
erases solid-colore
fareas to transparen(

Y

pattern. snapshot into thésimulate the look ofwith a single click.
current imag¥q different paint styles,
window using a selected state

or snapshot.

\Lﬁ% 0ol The background The gradient tool§The paint bucket tool
m.\ els anfleraser tool Create straight-lingfills similarly colored
#+ nsofaferases areas tpradial , angleflareas with the
reviously transparency reflected , andforeground color
* diamond , blends
between colors.
The blurtooblurs | The sharpentool | The smudgetool | The dodge tool
hardedgesinan | sharpens soft edgeq smudges data in an | lightens areasin an
image. in animage. image. image.
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The burn tootlarkens

areas in animage.

The type mask
toolscreate a

selection in the shap

The sponge tool
changes the color

The pen tooldet you
draw smooth-edged

Paths.

saturation of an ares

The path selection

.segment selections
showing anchor

and direction points.

The custom shape

toolsmake shape or

points, direction lineg,

The type toolereate
type on an image.

The annotation

tool makes
customized shapes

toolsmakes notes
and audio annotation

of type. selected from a that can be attached
custom shape list.  [to animage.

The eyedropper togThe measure tool | The hand tooinoves§ The zoom tool

samples colors in apmeasures distancesan image within it$ magnifies  and

image.

locations, and angleg

5 window,

reduces the view o
animage.

S
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To select a tool:  Click its icon or press its keyboard shortcut.
If the icon has a small triangle at its lower right corner, hold down
the mouse button to view the hidden tools. Then, click the tool
you want to select.

9.5.2 Quick tour to Adobe Photoshop
Opening a new file

Click File g New, it will open a window where you have to specify
Name, Width, and Height etc of the working area, shown in the
following figure

Fig. 9.7
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On clicking OK, a window, the working area with name untilted-
1 will be opened i.e. Shown in following figure:

Fig. 9.8

Using Adobe Photoshop’s Layers window

The Layers window shows the various layers that your image is
made up of.

To make a new layer, click the New Layer
button, as shown by the red arrow.

To work on a different layer, click on that
layer. The eyeball will apear next to that
layer.

You can drag layers up and down the list.

Remember — Create a new layer for each
part of your image. This allows you to go
back and edit the layers individually.
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Selection

One of the most important concepts
n Adobe Photoshop is Selection.

This is the Rectangular Selection
Tool.

Use this tool on your image to select
an area of the image. This lets
Photoshop know that that's the area

you want to work on.

Lasso Tool - Allows you to draw a selection area with the
Cursor.

Adding to a Selection and making a square

To add to a selection, hold Shift before
dragging.

To make the selection exactly square,
start dragging, then hold Shift.

You can press Ctrl+D to “deselect” and
remove the selection at any time.

Elliptical Selections and subtracting Selections

Hold down on the Selection Tool
on the Toolbar, and choose the
Ellipse.

To move the selection, just click
inside it and drag.

Holding ‘Alt’ key while selecting
subtracts that area from the
selection.
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Choosing a color

Before get started on coloring your selection, you will
need to pick a color.

This part of the Toolbox is where you select your
colors.

The top square is the foreground color. If you use a
brush or paint bucket, it will apply this color.

The bottom square is the background color. It has
various purposes, but it's also a good place to store

a second color that you're using.

Click on either squar to change its color

Click the arow to swap the two colors.

Click the little squaes to eset the colors to black and whi

The Paint Bucket and Gradient tools

These two tools are on separate buttons in Adobe

Photoshop 5.0, but share a button in Adobe

Photoshop 6.0 and Adobe Photoshop 7.0. To
select one, click and hold.

On a new layer, just click the Paint Bucket tool
inside the area of your selection to fill it with the
colour you've selected.

Click and drag from one area to another to fill
the area. The point where you started to click will
be the foreground colour, and the point where you
took your finger off the mouse button will be
background colour. The area in between will
gradually change from one color to the other.

Other Adobe Photoshop tools of interest include:
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The Text Tool - Justclick it wherever you want text to appear.
Choose a font, colour, and size, and start typing.

The Move Tool - Use this tool to drag things around. If you
have a selection, it will drag the contents of the selection. If not,
it will drag the contents of the layer you're on.

9.5.3 Sample Examples

Example 1 : Creating a Flower Petal

Follow the steps to create a flower Petal:

I The objective of this step is to rotate and cut the edge
off an ellipse, to make half a petal shape.

a. Create a new layer.

b. Use the Elliptical Selection Tool to select an elliptical area.
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a.

b.

Choose a darkish red colour, and fill the area with the Paint
Bucket Tool.

Press Ctrl+D to remove the selection.

Press Ctrl+T to transform your shape. Drag a corner
around, to rotate your shape, until it's in a position similar
to the one shown in the diagram than press Enter key.

With this Selection tool, select a large part of your shape
that you wish to cut off, so that the remaining part of the
shape resembles half a petal. Go back and rotate the shape
if need to. After section- go to Edit — Cut to cut off the
selected area.

Creating a Whole Petal

Right-click on your petal layer in the Layers list. It should
be called "Layer 1".

Click Duplicate Layer.

c. Click Edit g Transform g Flip Horizontal

d.

Choose the Move Tool, and use the arrow keys to nudge
the two half-petals around until they join to make a whole
petal. Note: pressing Shift and an arrow key nudges the
object around by 10 pixels at a time, instead of 1.

. Click on the "Layer 2" layer in the Layers list. This should

be your new, rotated half of the petal. Press Ctrl+E to merge
this layer down, so that the petal is all on one layer.
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3. Adding Texture and Lighting to the Petal

e.

Click Filter g Noise g Add Noise. Setitto around 10%,
Gaussian, Monochromatic.

Set your colors back to black and white, and then
switch the colors, by using the little icon, or pressing
"D".

In the Layers list, right-click this layer and choose
Blending Options. Click Gradient Overlay. Set the
Opacity to 25%, but leave the Mode as Normal. Set

the Angle to 90° and change the Style to Reflected.
Press OK.

Ctrl+Click this layer in the Layers list to select its area.

Choose the Brush Tool. Click the drop-down box
and choose the size 35 blurry brush. Set the brush’s
Opacity to 20%. Apply the brush around the outside
of the petal, to create a shadowy area, as shown.

Press Ctrl+D to deselect.

4. Saving a File

Photoshop provides several ways for you to save files

Go to File menu and, click on save; the file will be
saved in its current file format(.PSD)

Goto file menu and click  Save As. This lets you save
an alternate version of the file in a different format.

Go to File menuand, clickon Save for Web. This lets
you save the file in a format that can be used in a web.

0] Saving as JPEG

To save in .JPEG format: goto  File g Save As g give File name
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g Choose the format JPEG g click Save g specify image
options(Quality — Maximum, high, medium or low) g click OK

/] Same way you can save file in  GIF format

Example 2: Creating a navigation menu

Follow the steps to create a navigation menu:

1. Create a new image in Photoshop, around 30 pixels high
by 550 wide.

2. Fill it with the same orange you used in the header.

3. Use the Type Tool, and insert appropriate white text for

your navigation bar. To separate out the words, put a Bar
between each word (press Shift +\)

4. Click File > Save for Web.

INTEXT QUESTION

1. Write True or False for the following:

(@) Dynamic Hyper Text Make up language is a new web
page creation software.

(b)  Hit counters are used to track the number of times
the page has been accessed.

(c) Lasso Tool allows the user to draw a selection area
with the cursor.

(d) .PSPis the file format for saving a file in photoshop.

(e) The commonly used audio formats are AVI and
MPEG.

9.6 ANIMATION USING MACROMEDIA FLASH

Flash is a revolutionary technology on the Internet through which
multimedia content sites can be developed with ease. Websites
made up of music, videos and custom graphic intensive
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interfaces are all possible with Flash.

9.6.1 What is flash?

| Flash is a multimedia graphics program specifically for use
on the web.

| Flash enables you to create interactive movies on the web.

| Flash uses vector graphics, which means that the graphics
can be scaled to any size without loosing clarity/quality.

| Flash does not require programming skills and easy to
learn.

9.6.2 Getting started with Flash

The Flash workspace

The workspace provides easy access to everything you need to
create a movie.

_—r

Lavers TimeLine Frame

Stage

Toolbox Panel Set

Property Inspector / ActionScript
VA

Fig: 9.9
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The workspace consists of the following components:
| Stage

The stage is where you draw and import art work, add text
and sound, and add additional features such as navigation
buttons or user interface components.

| Toolbox

The toolbox contains tools, you'll use to create, place and
modify text and graphics.

| Panels

The panels in flash assist you in working with objects on
the stage, the entire document, the Timeline, and actions.
You can display the panel set you use most often by
choosing Window? Panel Sets or by creating custom Panel
Set.

| Timeline

The Timeline organizes and controls a movie’s content over
time.

Like films, flash divides length of time into frames, each
frame can have its own content, or it can use the content
of a previous frame.

| Layers

To help organize the content, the Timeline is divided into
layers. A background layer, for example, may carry over into
each frame of a movie, while an animation layer may be for
a specific frame.

| Property Inspector

The Property Inspector displays the most frequently used
settings for a tool or object.

| ActionScript

ActionScript is the built in programming language provided
with flash. You can create ActionScript in the actions panel.
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9.6.3 Working with Flash

Creating a Flash Button

Follow the steps to create a moving object:

1.

Start a Flash Document : go to Star tg All Program ¢
Macromedia g Macromedia Flash MX ( This will open a
new flash document with name Untitled-1)

From the Tools window select the Oval shape tool.

Select the red fill and the  black stroke from the Properties
window:

Hold shift and left click on the stage and drag to create a
circle like the one we have below.

Select the arrow tool from the Tools menu and double click
the circle to select both the red fill and the black stroke.
Right click the circle and choose Convert to Symbol
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Name: My_Button, Behavior: Button, Registration: Center/
Center

Press OK

6. With the arrow tool, double click My_Button to bring up the
symbol edit mode for My_Button. We are now going to
change the behavior when the user mouses over the
button. Choose the  Over column from the timeline for My
Button.

Insert KeyFrame in the Over state. (A shortcut for inserting
Keyframes is the F6 key or select the state Over and press
right click to insert Keyframe)

7. With frame Over still selected, double-click the circle to
select it and choose a blue fill from the Properties window.

8. Select Down in the Timeline for My_Button and insert a
KeyFrame for Down .

With frame Down still selected, double-click the circle to
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10.

select it and give it a yellow fill using the Properties window.

Testing Out Button States

Go to the Flash menu and navigate to: Control g test Movie.
Mouse over and click your button. Notice that it changes
colors!

Adding a Button Action: GetURL

Now we want our button to actually do something, so let's
make it so when you click the button it loads up the
NIOS(National Institute of Open Schooling) website
nios.ac.in. From the menu choose: Edit g Document

Right click our button and choose "Actions" from the pop

up menu if it is not already selected. Within the Actions
Toolbar select: Action g Browser/Network g getURL . Be
sure that your Script Assist is enabled.

Double click getURL to create a new getURL action, which
also brings up the text fields you will need to manipulate.
In the URL field type in: http://www.nios.ac.in In the
Window field type or select: _blank
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11. Finish Button Creation!

You're done creating a fully function Flash Button! From the
menu choose: Control g Test Movie to test out your flash
button. When you click the button it now launches website

of NIOS!

12. Saving Flash Document

Goto File g Save As g give File Name say myButton, click
Save

Flash MX Document’s are saved with an extension .fla i.e.
the file saved as myButton.fla

9.6.4 Flash Embedded in HTML

To embed the Flash movie you just made into an HTML page, you
should go back to your Flash program and do the following steps:

Step-1

Choose File g Open. Open a Flash movie you have created.
Step-2

Choose File g Export Movie

Step-3

Name the file "somefilename.swf ", say myButton.swf. Choose the
location where the file is to be stored (in your Web folder). Click
OK.

Step-4

Open the HTML page where you want to insert your Flash movie.
Insert this code:

<object width= "550" height= "400">

<param name= "movie” value= "somefilename.swf ">
<embed src= "somefilename.swf " width= "550" height= "400">
</embed>

</object>
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Note: This is the minimum code you need to embed a Flash
movie in a browser. A broken icon will appear on the Web page
if the user does not have the Flash plug-in installed.

Note: In the code above there is both an <embed> tag and an
<object> tag. This is because the <object> tag is recognized by
Internet Explorer, and Netscape recognizes the <embed> tag and
ignores the <object> tag.

Step-5
Type in the address of the HTML file in your browser and look at
your first Flash movie.

9.6.5 Flash Animation: Tweening

The basic idea behind tweening is to create animation by taking
two points in time and automatically creating an animation to fill
in the gap between them.

Tweening comes from the words " in between

With Tweening you can go from one keyframe to another and
specify changes in the animation and let the Flash program create
the frames in between.

Example -1
How to make an object move across the screen.

Follow the steps to create a moving object:
Step-1

Create a small circle to the left in the Stage area. Do this by
selecting the circle tool from the left toolbar. Draw the circle in
the Stage area.

Step-2

Select the Arrow tool from the left toolbar. Double-click on the
circle to select it.

Step-3

Now we have to convert the circle to a symbol. When the circle is
converted to a symbol we can create instances of the circle. From
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the top menu choose Modify > Convert to Symbol. Name the
symbol “Ball”, and select OK.

Step-4

Go to Frame 50 in the Timeline. Do this by clicking the gray field
below 50. Then right click in this field. Choose Insert Keyframe.
Keyframes appear as circles in a frame. This operation duplicates

the image.

Note: A keyframe specifies changes in an animation. You create
keyframes at important points in the Timeline and let Flash
create the frames in between.

Step-5
Select the circle and move it to the right a couple of inches.
Step-6

Click on the Timeline any place between Frame 1 and Frame 50.
Then right click and choose Create Motion Tween.

Step-7

Choose Control g Test Movie from the top menu to test your Flash
movie.

Example-2
How the text moves across the screen.
Follow the steps to create a moving text:

Step-1

Insert a text in the upper left corner of the Stage area. Do this by
selecting the text tool from the left toolbar. Write some text in the
"textarea".

Step-2

Select the arrow tool from the left toolbar. Click on the text once
to select it.
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Step-3

Convert the text to a symbol. From the top menu choose Insert
g Convert to Symbol. Name the symbol "text", choose graphic
from the Behavior list and select OK.

Step-4

Go to Frame 30 in the Timeline. Do this by clicking the gray field
below 30. Then right click in this field. Choose Insert Keyframe.
Keyframes appear as circles in a frame.

Step-5

Click on the Timeline any place between Frame 1 and Frame 30.
Then right click and choose Create Motion Tween.

Step-6

Go back to Frame 30 in the Timeline. Move the text to the lower
right corner.

Step-7

Make sure the text is selected. Choose Modify g Transform ¢
Flip Horizontal

Step-8

Choose Control g Test Movie from the top menu to test your
Flash movie. The text should move from the first location (in
frame 1) to the second location (in frame 2). The text should also
turn around on its way to the second location.

INTEXT QUESTION

2. Write True or False for the following:

(@) Flash is multimedia graphics program use in web
designing.

(b)  The property Inspector displays the most frequently
used setting for a tool or object.
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(c) Choose modify g Transform g Flip Horizontal to test
Flash movie.

(d) Flash divides length of time into frames.

9.7 WHAT YOU HAVE LEARNT

In this lesson we discussed about the concept of multimedia in
webpage. Here we described how to use photoshop in image
processing. You also learnt the step by step use of Flash in
animation.

9.8 TERMINAL QUESTIONS

1. Why use Multimedia in your web page? How to embed
Audio/Video in web page?

Using Adobe Photoshop:

2. Try out the different kind
of Selection shown in
figure.

3. Create the objects as
shown in figure and fill
appropriate color.

4. Cerate the leaf as shown in
figure
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Using Macromedia Flash

1. Create an elliptical button with changing color on mouse
over and moue down, create a link to the website http://
google.co.in, and use this in your web page.

2. Create an object and to move it horizontally across the
screen.
3. Move your name left to right across the screen.

9.9 FEEDBACK TO INTEXT QUESTIONS

1. (a) False
(b) True
(c) True
(d) False
(e) True
2. (a) True
(b) True
(c) False

(d) True




